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Chapter

Installing
RSView32 Messenger

About RSView32 Messenger
RSView32 Messenger™ is a voice alarm notification, paging, reporting, and
messaging system. It is an add-on to RSView32™.
With Messenger you can announce alarms locally using a computer sound or
voice card, or over a telephone using a voice card. You can also send alarm
notification to pagers, fax machines, e-mail addresses, or to an RSView32
Active Display Client computer. In addition, you can create a schedule of alarm
notification destinations. This lets you accommodate holidays, weekends, and
other times when you might want notification sent off-site to personnel who
are on call.
Messenger alarm notification works with RSView32, extending and enhancing
its alarm capabilities.
In addition to announcing alarms with Messenger, you can create messages and
reports about alarm activity and tag activity. These reports can be sent to the
same destinations as alarms.

About Messenger Pro
If you purchase an RSView32 Messenger Pro™ license, you can use these
additional features:



Send file attachments with e-mail notifications.
Dial in using a regular phone line, to hear and respond to alarms, hear status
phrases, or run RSView32 commands or macros.

You must activate the Messenger Pro license on your run-time system, as
described later in this chapter.
■

1

System requirements
To run RSView32 Messenger, the recommended requirements are:
with an Intel® Pentium® processor. 200 MHz or
faster processor recommended. 300 MHz or faster to use voice card.



Personal computer (PC)



Memory.



Hard disk space.



64 MB recommended.
Minimum 50 MB.

Microsoft® Windows NT® 4.0 or later (with Service
Pack 3); Windows 9x; Windows 2000 Professional or Server, or
Windows XP Professional.
Operating system.

®







Modem. To communicate with pagers or fax machines, you need a
Windows-compatible fax-modem. For sending e-mail, either a modem,
network, or Internet connection is required.
Sound card. To announce alarms over loudspeakers, you need a Sound
Blaster®-compatible sound card and speakers.

You must use a voice card to send alarm notification to a
telephone, or to use dial-in access. Messenger supports the Intel Dialogic®
ProLine/2V voice card and the Intel Dialogic D/4PCI voice card.

Voice card.

If you use the D/4PCI voice card, Messenger Pro supports channels 1
and 2 on the voice card.
The ProLine/2V card is an ISA card. Make sure your PC has an ISA slot
before purchasing this card.



RSView32 software.

RSView32 6.3 or later.

Microsoft Exchange e-mail. To send e-mail, you need Microsoft Exchange
e-mail. Other MAPI-compliant e-mail systems might work as well. (MAPI
is the Messaging Application Program Interface.)

For detailed information about calculating system requirements, see the
RSView32 Readme file.

2
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Installing RSView32 Messenger
Installing Messenger on Windows NT,
Windows 2000, or Windows XP
As part of the installation process, Messenger creates program folders and
modifies registry entries. In order to make these modifications, Messenger
must be installed on a Windows computer that is set up with these rights (for
example, the Windows administrator account has these rights).

Installation steps
The steps below explain how to install Messenger software from a CD-ROM
to your computer. Before installing Messenger, be sure that RSView32 6.3 or
later is installed on the computer.
1.

Close all open Windows programs.

2.

Place the RSView32 Extensions CD-ROM in your CD-ROM drive. The
CD should start running automatically.
If the CD does not start automatically, run D:\Setup.exe where D is the
drive containing the CD.

3.

Follow the on-screen instructions.

4.

When installation is complete, restart Windows. If you do not restart
Windows now, be sure to restart it before running Messenger for the first
time.

Installation summary
The default installation installs RSView32 Messenger in \Program
Files\Rockwell Software\Messenger.

Activating RSView32 Messenger Pro
Rockwell Software uses activation files to activate some of its Windows-based
software packages. You do not need to activate RSView32 Messenger.
However, if you purchased an RSView32 Messenger Pro license, you must
activate it on the run-time computer.

Installing RSView32 Messenger
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The activation files reside on the Activation disk. During installation, the
software prompts you to insert the Activation disk and move the activation key
from the disk to the drive where you’ve installed RSView32 Messenger Pro.

About the Activation disk
RSView32 Messenger Pro comes with an Activation disk (may also be referred
to as a Master disk) that activates the RSView32 Messenger Pro software.
Without activation, the RSView32 Messenger Pro features are not available at
run time.
The Activation disk contains:


one or more activation keys.
The activation key is the software that activates RSView32 Messenger Pro.
Depending on what you purchased, your Activation disk will have one or
more activation keys. For example, if your company purchased four
RSView32 Messenger Pro installations, you require four activation keys.
Multiple copies of the same software require activation keys with matching
serial numbers. All of the activation keys can be on the same Activation
disk.





a program called EVMOVE.EXE that moves activation keys to and from
computers.
a program called RESET.EXE that reactivates a damaged activation key.

You can move activation keys to and from the Activation disk. The programs
EVMOVE.EXE and RESET.EXE always stay on the Activation disk.

Activation keys
The activation key for RSView32 Messenger Pro is called RSVMSGR.PRO.
To view the keys on your Activation disk
1.

Insert the Activation disk into a diskette drive.

2.

In the File Manager, Windows Explorer, or My Computer, select the drive
containing the diskette.

3.

Start EVMOVE.EXE.
The EvMove Summary dialog box opens showing your activation keys.

4
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Moving activation keys back to the Activation disk
You can move the activation key back to the Activation disk at any time. For
example, move activation back to the Activation disk:





to run RSView32 Messenger Pro on a different computer.
before installing or using software that could damage your activation files
(see “Protecting your activation files” on page 6 for a list of specific
operations that can damage activation).
before sending your computer to a technician.

By default, when you move activation keys back to the Activation disk, the
software automatically moves all activation keys for the appropriate product.
To move activation keys back to the Activation disk
1.

Ensure RSView32 Messenger Pro and all other Rockwell Software
products are closed.

2.

Insert the Activation disk into a diskette drive.

3.

Run A:\EVMOVE.EXE where A is the diskette drive containing the
Activation disk. The EvMove Summary dialog box opens.

4.

In the From box, select the drive where RSView32 Messenger Pro is
installed. In the To box, select the drive containing the Activation disk.
Click OK.

5.

Either move activation keys for all installations or for a selected number of
installations.



6.

To move activation keys for all installations, click Move.
To change the number of activations to move to the Activation disk,
select the activation key, and then click Edit Selected. In the Move box,
type the number of activation keys to move. Click OK, and then click
Move.

To close the EvMove Summary dialog box, click OK.

Installing RSView32 Messenger
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Activating RSView32 Messenger Pro after
installation
You might need to reactivate RSView32 Messenger Pro after moving activation
keys back to the Activation disk or after resetting a damaged key. To reactivate
RSView32 Messenger Pro, move the activation key from the Activation disk
back to the hard drive.
By default, when you move activation to a hard drive from the Activation disk,
the software moves only one “install” of an activation key for RSView32
Messenger Pro.
To move activation keys to the hard drive
1.

Ensure RSView32 Messenger Pro and all other Rockwell Software
products are closed.

2.

Insert the Activation disk into a diskette drive.

3.

Run A:\EVMOVE.EXE where A is the diskette drive containing the
Activation disk. The EvMove Summary dialog box opens.

4.

In the From box, select the drive containing the Activation disk. In the To
box, select the drive where RSView32 Messenger Pro is installed. Click
OK.

5.

Either move activation keys for all installations or for a selected number of
installations.



6.

To move activation keys for all installations, click Move.
To change the number of activations to move, select the activation key,
and then click Edit Selected. In the Move box, type the number of
activation keys to move. Click OK, and then click Move.

To close the EvMove Summary dialog box, click OK.

Protecting your activation files
Performing certain operations on your hard drive can damage activation files.
Always move activation keys from your hard drive back to the Activation disk
before doing any of the following operations. After completing the operation,
it is safe to move the activation keys back to the hard drive and reactivate
RSView32 Messenger Pro.
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Move activation files back to the Activation disk before:
Upgrading,
installing, and uninstalling operating system software or networking system
software can damage the activation files.



Upgrading or installing your computer’s operating system.



Compressing or uncompressing your computer’s hard drive. Compressing

the hard drive with some compression software programs can damage
activation software. In addition, uncompressing a hard drive with activation
files on the compressed drive can damage activation.

Reactivating a damaged key
If your activation key becomes damaged for any reason, contact Rockwell
Software Technical Support for a reset code—440-646-5800.
When you call

When you call, be at a computer. You do not have to use the same computer
that RSView32 Messenger Pro is installed on. However, you must have the
Activation disk with a serial number that matches the RSView32 Messenger
Pro software.
The support representative will explain how to find the product ID and system
ID from the Activation disk and then will assign a reset code for the activation
key. After obtaining a reset code from the technical support representative,
reset the key, and then reactivate RSView32 Messenger Pro.
To reactivate a key with a reset code
1.

Ensure RSView32 Messenger Pro and all other Rockwell Software
products are closed.

2.

Insert the Activation disk into a diskette drive.

3.

Run A:\RESET.EXE where A is the diskette drive containing the
Activation disk.

4.

In the Reset Code dialog box, type the reset code, and then click OK.

5.

Reactivate RSView32 Messenger Pro, following the steps in “Activating
RSView32 Messenger Pro after installation” on page 6.

Installing RSView32 Messenger
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Troubleshooting activation
If activation is not working:








Are you using the right Activation disk? Check the serial numbers on your
RSView32 Messenger Pro software and printed on your Activation disk
labels—the serial numbers must match.
Does your computer have a virus? Boot sector viruses can damage your
Activation disk. The Rockwell Software support team recommends using a
commercial virus protection program.
Did you save other files on the Activation disk? Saving any files to the
Activation disk can damage the activation software.
Did you perform an operation on your hard drive that damaged the
activation software? See “Protecting your activation files” on page 6.

Starting RSView32 Messenger
When you have installed Messenger, a folder containing three editors appears
in the RSView32 Program Manager. Double-click any editor to open it; or
right-click an editor, and then click Show.

For information about using these editors, see Chapter 2, Getting started. Or, see
Help.
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2
Chapter

Getting started

Welcome to RSView32 Messenger
RSView32 Messenger™ is an optional extension to RSView32™, for creating
and using customized voice and text alarm messages and reports. You can send
alarm messages and reports to plant speakers connected to sound or voice
cards, to pagers, e-mail addresses, fax machines, and telephone numbers, and
to RSView32 Active Display Client computers.
You can use RSView32 security to prevent unauthorized access to RSView32
Messenger and Messenger commands at run time. See RSView32 Help for
information about setting up security.

Additional features with Messenger Pro
If you purchase an RSView32 Messenger Pro™ license, you can use these
additional features:



Send file attachments with e-mail notifications.
Dial in using a regular phone line, to hear and respond to alarms, hear status
phrases, or run RSView32 commands or macros.

You must activate the Messenger Pro license on your run-time system, as
described in Chapter 1, Installing RSView32 Messenger.

■
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The Messenger editors
The Messenger folder in the RSView32 Project Manager contains three editors.

Use Messenger Setup to:


set up how the voice will sound (using text-to-speech software).



select tags to monitor for alarms.



record and import sounds, words, and phrases.



set up security for dial-in access, including the greeting users will hear.



set up dial-in phone menus that users can select from.

Use Messenger Destination Setup to:


set up the destinations (telephones, pagers, faxes, e-mail, sound card
speakers, voice card speakers, and RSView32 Active Display Client
computers) for alarm messages and reports.



specify destinations for alarms of different severities and for alarm events.



specify alarm messages and alarm event messages.





set up a schedule for who’s on call to receive alarms or reports during the
week, on weekends, and on holidays.
specify which days are statutory holidays, and which days are special
holidays that relate to your plant or business.

Use Messenger Reports to create reports about alarm activity and other tag
activity.

10
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Setting up how messages sound
Messenger comes with text-to-speech conversion software that automatically
provides spoken versions of all RSView32 tag names and logging messages.
You can also record messages yourself, and then include them in alarm
messages and reports. If you want to use text-to-speech, you can choose
whether the text-to-speech voice is male or female, and you can provide
pronunciations for unusual or industry-specific words.

Using the RSView32 Messenger sample project
Installing Messenger also installs a sample project that you can use to see how
Messenger is set up and to test the program before using it with your own
projects.
To see Messenger data in action, and to get ideas for setting up your own
projects to use Messenger, open the RSView32 Messenger sample project.
To open the sample project


Click the Windows® Start button, and then select Programs>Rockwell
Software>RSView32 Messenger>RSView32 Sample Messenger Project
(Messengerdemo.rsv).

Quick start steps
The following steps explain how to get up and running with Messenger. To
work with Messenger, you must complete step 1. The other steps are optional
and can be completed in any order.
For more detailed information than is provided in this manual, see Help.

Step 1



Set up communications

To start using Messenger right away, all you need to do is install a sound card
and issue the MessengerOn command.
If you want to use Messenger to send alarm notification or reports to pagers,
e-mail addresses, fax machines, phone numbers, or RSView32 Active Display
Client computers, set up destination information in Messenger for each
communication method you plan to use. Then test communications to ensure
everything is set up correctly.

Getting started
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Set up destinations in the Destinations tab of the Messenger Destination Setup
editor.
For details, see Chapter 3, Setting up communications.

Step 2



Set up alarm monitoring

You can specify which tags are monitored for alarms, as well as where and
when different alarm messages are sent.


By default, Messenger monitors and announces alarms for all the tags in the
RSView32 tag database for which you have defined alarms. To change the
default, you can select individual tags to monitor.
Specify the tags to monitor in the Alarm Tags tab of the Messenger Setup
editor.



You can send alarm messages to different destinations for different alarm
severities or events. For example, you can route all Severity 1 alarms that
remain unacknowledged for 60 seconds to a plant-floor supervisor’s cellular
phone, while routing alarms of all other severities to destinations according
to a schedule. At the same time, you can set up Messenger to announce
every alarm acknowledgement over the plant’s loudspeakers.
Specify the destinations for messages for different alarm severities and
events in the Alarm Severities tab of the Messenger Destination Setup
editor.



You can set up a schedule to specify which destinations receive calls at
certain times of day, over the weekend, or on holidays.
Set up schedule details in the Schedule and Holiday Setup tabs of the
Messenger Destination Setup editor.

For details, see Chapter 4, Setting up alarm monitoring.

Step 3



Set up phrases, messages, and reports

You can use Messenger to announce customized alarm messages, issue
message announcements that you create at run time, or deliver pre-defined
reports at regular intervals. You can control what form the information appears
in, and even how it sounds.

12
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You can use the text-to-speech software that ships with Messenger to
customize how audio message announcements sound. You can select from
a variety of synthesized male and female voices, and control how unusual or
industry-specific words are pronounced.
Set up the text-to-speech software in the Setup tab of the Messenger Setup
editor.



You can create and import audio recordings to use in your messages and
reports. For example, you can record a tag name description to include in a
message. Or you can import a bell tone to use at the beginning and ending
of message announcements.
Create and import audio recordings in the Audio Recordings tab of the
Messenger Setup editor.



You can use the specific in-alarm, out-of-alarm, and acknowledge messages
that have been set up for each tag in RSView32, or you can use standard
messages that you set up in Messenger. You can also set up standard
messages for alarm faults and alarm suppression events.
Specify the alarm messages to use in the Alarm Messages tab of the
Messenger Destination Setup editor.



You can create reports for many purposes. For example, you can create a
report about the operational status of the plant, and then e-mail the report
to shift supervisors and management. Or you can keep people up-to-date
by regularly sending a status report—for example, once every hour—to one
or more pagers or telephone numbers.
Set up reports in the Reports editor.



At run time, you can create messages to report current plant activity. These
messages, which are generally shorter than your pre-defined reports, are
called “phrases.”
Type phrases on the command line, using the MessengerPhrase command.

For details, see Chapter 5, Setting up phrases, messages, and reports.
You can issue Messenger commands from the command line, or include them
in an event, a macro, VBA code, or anywhere else that RSView32 commands
are used.

Getting started
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Step 4



Set up dial-in access

If you purchase a Messenger Pro license, you can set up dial-in access to allow
operators to phone in to hear and respond to alarms, hear status phrases, or run
RSView32 commands or macros.


You can use the pre-defined greeting and log-in prompts provided with
Messenger Pro, or create your own audio prompts.
Set up a greeting and log-in prompts in the Phone Security tab of the
Messenger Setup editor.



You can customize the pre-defined menu system, which provides the caller
with a main menu and submenus to choose from, and you can create a
custom menu for issuing commands and macros or playing recorded
phrases.
Set up phone menus in the Phone Menus tab of the Messenger Setup editor.

For details, see Chapter 6, Setting up dial-in access.
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3
Chapter

Setting up
communications

Quick start
To start using RSView32 Messenger™ right away, all you need to do is install a
sound card and issue the MessengerOn command.
To issue the command, start your RSView32™ project, and then on the
command line type MessengerOn.
To test that Messenger is working and the sound card is installed properly, on
the command line type this:
MessengerPhrase “Testing sound card”
When you use this quick start method, Messenger:







announces alarm messages over the local Windows® sound card.
monitors and announces alarms for all RSView32 tags for which alarms are
defined.
uses the default alarm messages in the Alarm Messages tab of the
Messenger Destination Setup editor (not the alarm messages that have been
set up for the tags in RSView32, if any).
uses the default text-to-speech pronunciation for tag names and
descriptions.

■
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Setting up destinations
In addition to sending alarms or reports to speakers attached to a computer’s
sound card, you can send alarm messages or reports to people who are not on
the plant floor. Destinations you can use include e-mail addresses, the phone
numbers of pagers, telephones, cellular phones, and fax machines, and
RSView32 Active Display Client computers.
To add a destination, use the Destinations tab in the Messenger Destination
Setup editor.

Choose where
to send
messages and
reports...
...and then fill
in the details
about the
destination.

16
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Setting up pager destinations
Before you set up pagers in Messenger, install a modem and set it up to dial out
of your building correctly.
1.

In the Destinations tab in the Messenger Destination Setup editor, click
Add, and then type a name for the destination.

2.

In the Destination type box, select Pager.

3.

Click Import, and then select the pager service you use.
If your pager service is not listed, click New and set up the pager service
using the configuration details provided by your service.

4.

In the PIN number box, type your pager number.

5.

In the Pager service box, select your pager service.

6.

Click Retries, type the number of times to retry the pager before giving up,
and then click OK to close the dialog box.

7.

Click OK to save your changes.

8.

Start your RSView32 project, and then on the command line type
MessengerOn.

9.

To test that the pager is set up properly, on the command line type this:
MessengerPhrase “Testing pager” /dPagerDestinationName
If the pager destination is set up properly, the phrase “Testing pager” will
appear on your pager. If you do not receive a response from your pager, go
back to step 1 and verify your settings. You can also verify the settings with
your pager company.

Setting up communications
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Setting up fax destinations
Before you set up fax destinations in Messenger, connect your computer’s faxmodem to a COM port.
1.

In the Destinations tab in the Messenger Destination Setup editor, click
Add, and then type a name for the destination.

2.

In the Destination type box, select Fax.

3.

In the Number box, type the phone number for the fax machine. If you
have to dial 9 to get an outside line, type a 9 and a comma before the
number.
For example, type 9,555-1212.

4.

In the Initialization box, type the initialization string to send to the fax
modem, if one is required.

5.

In the Connect using box, select the COM port to which your fax-modem
is connected.

6.

Click OK.

7.

Start your RSView32 project, and then on the command line type
MessengerOn.

8.

To test that the fax destination is set up properly, on the command line
type this:
MessengerPhrase “Testing fax” /dFaxDestinationName
If the fax destination is set up properly, the phrase “Testing fax” will
appear on a fax sent to you. If you do not receive a message on your fax
machine, go back to step 1 and verify your settings.
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Setting up e-mail destinations
Messenger requires the use of a local area network to send e-mail.
1.

In the Destinations tab in the Messenger Destination Setup editor, click
Add, and then type a name for the destination.

2.

In the Destination type box, select E-mail.

3.

In the E-mail address box, type the full e-mail address. For example,
yourname@yourcompany.com. (For testing purposes, set up a destination
that uses your e-mail address first.)

4.

In the E-mail subject box, type a subject line for the e-mail, if desired.
This subject line will be used for all alarm messages sent to this destination.
You can include phrases and tag properties in the subject line.

5.

To insert a tag property or pre-recorded phrase in the subject line, click
Browse and then select a property or phrase from the Phrase Components
dialog box.
For more information, see the next section.

6.

If you purchased an RSView32 Messenger Pro™ license and want to send a
file attachment with the e-mail, type or select the name of the file to send.
For example, you might want to send an alarm log file.
To use file attachments, Messenger Pro must be activated on the run-time
computer. For information about activating Messenger Pro, see Chapter 1,
Setting up communications.

7.

To send the most recent file in a series of files, check Autoselect.
Messenger checks the name of the base file specified in the Attachment file
box, and then checks for files with the same name but with a higher
number. The file with the highest number is sent.
For example, you could use this option to send the most recent alarm log
file with the e-mail message.

8.

Click OK.

9.

Start the program you use to send e-mail (with a current Internet
connection).

10. Start

your RSView32 project, and then on the command line type
MessengerOn.

Setting up communications
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11. To test that

the e-mail address is set up properly, on the command line type

this:
MessengerPhrase “Testing e-mail” /dEmailDestinationName
12. Check

your “Sent Items” folder. E-mails sent by Messenger should appear
here within a few seconds.

13. After

a few minutes, check your Inbox.

If the e-mail destination is set up properly, the phrase “Testing e-mail” will
appear in an e-mail sent to you. If you do not receive an e-mail response,
go back to step 1 and verify your settings.

Inserting tag properties
To insert a tag property into an e-mail subject line, position the cursor where
you want to insert, and then click the Browse (...) button to open the Phrase
Components dialog box.

To include a property in the subject
line, double-click it. If you are
inserting the property for a specific
tag, first specify the tag in the Tag
box.

To insert the property for a specific tag, type the tag name here, or
click Browse (...) to open the Tag Browser, and then select a tag.

At run time, when an alarm message is announced, Messenger sends an e-mail
message with the specified information in the subject line. The current values
of tag properties are displayed.

20

■

Getting Results with RSView32 Messenger

Setting up phone destinations
Before you set up phone destinations in Messenger, install an Intel® Dialogic®
ProLine/2V voice card or an Intel Dialogic D/4PCI voice card.
Messenger supports channels 1 and 2 on the D/4PCI voice card.
1.

In the Destinations tab in the Messenger Destination Setup editor, click
Add, and then type a name for the destination.

2.

In the Destination type box, select Voice card phone out.

3.

In the Number box, type the phone number to dial. If you have to dial 9 to
get an outside line, type a 9 and a comma before the number.
For example, type 9,555-1313.

4.

In the Channel box, select a channel on the voice card. If you also set up a
voice card speaker destination, Channel 2 is automatically used for that
destination.

5.

Click OK.

6.

Start your RSView32 project, and then on the command line type
MessengerOn.

7.

To test that the phone is set up properly, on the command line type this:
MessengerPhrase “Testing phone” /dPhoneDestinationName
If the phone destination is set up properly, you will hear the phrase
“Testing phone” in a phone call to you. If you do not receive a phone call,
go back to step 1 and verify your settings.

Setting up communications
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Setting up sound card speaker destinations
Before you set up sound card speaker destinations in Messenger, install a sound
card and speakers.
1.

In the Destinations tab in the Messenger Destination Setup editor, click
Add, and then type a name for the destination.

2.

In the Destination type box, select Sound card speakers.

3.

In the Voice box, select the speaker voice. If you select the default, the
speaker voice used is the one you select in the Messenger Setup dialog box.

4.

Click OK.

5.

Start your RSView32 project, and then on the command line type
MessengerOn.

6.

To test that the sound card speaker destination is set up properly, on the
command line type this:
MessengerPhrase “Testing sound card” /dSoundcardDestinationName
If the sound card speaker destination is set up properly, you will hear the
phrase “Testing sound card” on the speakers using the speaker voice you
selected. If you do not receive a response on the speakers, go back to
step 1 and verify your settings.
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Setting up voice card speaker destinations
Before you set up voice card speaker destinations in Messenger, install a voice
card and speakers.
Messenger supports the Intel Dialogic ProLine/2V voice card and the D/4PCI
voice card. Channel 2 is used for the voice card speaker destination. You
cannot select a different channel.
1.

In the Destinations tab in the Messenger Destination Setup editor, click
Add, and then type a name for the destination.

2.

In the Destination type box, select Voice card speakers.

3.

Click OK.

4.

Start your RSView32 project, and then on the command line type
MessengerOn.

5.

To test that the voice card speaker destination is set up properly, on the
command line type this:
MessengerPhrase “Testing voice card” /dVoicecardDestinationName
If the voice card speaker destination is set up properly, you will hear the
phrase “Testing voice card” on the speakers. If you do not hear a message
on the speakers, go back to step 1 and verify your settings.

Setting up communications
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Setting up the Active Display Client
To set up an RSView32 Active Display Client as a destination in Messenger,
you must also set up a graphic display using RSView32. The graphic display
must contain an ActiveX® control called RSView32 Messenger Client Control.
Create the graphic display containing the RSView32 Messenger Client Control
using the Graphic Display editor.
At run time, the display must be displayed and running in the background on
the client computer. The server sends alarm messages and reports to the client
through string tags.
Before you set up the RSView32 Active Display Client as a destination, check
that the client and the server are working properly.
1.

In the Destinations tab in the Messenger Destination Setup editor, click
Add, and then type a name for the destination.

2.

In the Destination Type box, select Active Display Client.

3.

To specify the string tag that stores the voice name you want to use, click
Browse (...). In the Tag Browser, select the string tag.
For example, to use the text-to-speech voice called Mary, create a string tag
with the value Mary. Select this tag in the box.

4.

Select a string’s row in the table, from 1 to 10, and click Browse (...) to
select a string tag that stores the alarm message or report.
You can specify a maximum of 10 string tags, with up to 82 characters for
each.

5.

In RSView32, perform the following steps:
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In the Graphic Display editor, create a new display. For detailed
instructions, see the RSView32 Help.
Add an RSView32 Messenger Client Control object.
Right-click the RSView32 Messenger Client Control object, and then
click ActiveX Property Panel.
In the Animation tab of the ActiveX Property Panel, select the string
tags you specified in steps 3 and 4 (such as, Message and Voice).
In the Properties tab of the ActiveX Property Panel, change the voice if
you want to use a different voice. To do this, double-click the Voice
property, and then type the name of the voice to use.

Getting Results with RSView32 Messenger



Right-click the graphic display, and then click Display Settings. Set the
Cache After Displaying option to Yes, and select Always Updating.
or
If you do not want the graphic display to be visible on the RSView32
Active Display Station, use the Display /ZA command for the display.
Messenger announces any changes in the tags that are continuously
being updated. Those tags are specified in the Messenger Destination
Setup editor. For more information about the Display /ZA command,
see the RSView32 Help.




Save the graphics display file.
Create a startup macro that clients can use to display the graphic display
containing the RSView32 Messenger Client Control object. For more
information about creating macros, see the RSView32 Help.
Do not use the FlushCache command. This command
removes the graphic display from the cache at the client. For more
information about the FlushCache command, see the RSView32 Help.

Important:

6.

In the Messenger Destination Setup editor, click OK.

7.

Start your RSView32 project, and then on the command line, type
MessengerOn.

8.

Start the RSView32 Active Display Station to open the graphic display file.
The RSView32 Messenger Client Control monitors the specified string
tags, plays the alarm message or report, and clears the string tags.

9.

To test that the client destination is set up properly, on the command line
type this:
MessengerPhrase “Testing Active Display Client” /dClientDestinationName
If the RSView32 Active Display Client destination is set up properly, you
will hear the phrase “Testing Active Display Client” on the speakers. If you
do not receive a response on the speakers, go back to step 1 and verify your
settings.

If you view the graphic display file containing the RSView32
Messenger Client Control object from the web browser, you must open a new
web browser window to view another graphic display file.

Important:

Setting up communications
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Turning destinations on and off at run time
You can turn destinations on and off using the MessengerDestinationEnable
and DestinationDisable commands. You can turn on all destinations at the
same time by using the MessengerOn command with the /E parameter.
See RSView32 Help for information about providing operators with ways to
issue commands at run time. See RSView32 Messenger Help for more
information about Messenger-specific commands.
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Chapter

Setting up alarm
monitoring

Specifying tags to monitor
By default, RSView32 Messenger™ monitors and announces alarms for all the
tags in the RSView32™ tag database for which you have defined alarms. To
change the default, you can select individual tags to monitor.
Whether to use all alarm tags depends on how frequently you expect alarms to
be generated. For example, if you choose to announce alarms for all tags,
alarms might be generated faster than they can be communicated to a
telephone, or, if you send alarms by e-mail, the number of alarms generated
might bring down the e-mail system.

■
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To specify the tags for which alarms will be announced, use the Alarm Tags tab
in the Messenger Setup editor.
To limit the number of tags
Messenger monitors, click here.

To add a tag to the
list, click Add.
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View details about the
selected tag here. To hear
what the text in the box will
sound like when spoken, click
Play (the button with the green
arrow on it).

Specifying destinations for alarm severities and
events
You can send alarm messages to different destinations for different alarm
severities and events.
To assign destinations to alarm severities or events, use the Alarm Severities tab
in the Messenger Destination Setup editor.
Click an alarm severity or
event...

If you choose to specify the
notification, set it up here.

...and then choose whether to specify the
destination or use the schedule to determine
the destination.

To display and select destinations,
click Browse (...) to open the Select
Destinations dialog box.

If you choose No destination for alarm severities or events, notification of the
alarm severity or event is not sent. For example, you might not want
notification to be sent when alarms are acknowledged. In this case, you would
set the Acknowledged event to No destination.

Acknowledging alarms
If you purchased an RSView32 Messenger Pro™ license, operators can
acknowledge alarms by dialing in to the run-time computer. Users can listen to
and acknowledge single alarms, or acknowledge all alarms. For more
information, see Chapter 6, Setting up dial-in access.

Setting up alarm monitoring
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Setting up notifications and destinations
For each alarm severity, you can set up three notifications, or you can let the
schedule determine which destinations will receive alarm notification. To set up
a notification, specify the time (in seconds) when the notification will take
place, and choose one or more destinations where the notification will be sent.
Similarly, for each alarm event you can either set up three notifications that will
be sent to one or more destinations at a specified time, or you can let the
schedule determine which destinations will receive alarm notification.
To assign destinations, click the Browse (...) button to open the Select
Destinations dialog box. You can specify up to 25 destinations.

Click the check
boxes to select a
destination or
multiple
destinations.
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Setting up continuous notification and
announcements
For alarms, you can set up continuous notification. Messenger continues to
send you notifications until the alarm is acknowledged. You can specify how
often you want notification and assign destinations.
Click to send further
notifications until
the alarm is
acknowledged.

Specify the notification time, between 1
and 99999 seconds. Click Browse (...)
to open the Select Destinations dialog
box.

For acknowledged alarms, you can set up Messenger to announce the
acknowledgement only if the tag is still in alarm at the time of the
acknowledgement.

Select to announce the acknowledgement
of a tag in alarm at the time of the
acknowledgement. Clear the check box to
announce all alarm acknowledgements.

Setting up alarm monitoring
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Setting up a schedule
You can set up a schedule to specify which destinations receive calls at certain
times of day, over the weekend, or on holidays.
For example, you can set up the system so that alarms are announced over
speakers attached to a computer’s sound card from Monday to Friday, between
the hours of 8 A.M. and 6 P.M., and you can have alarms announced via the
phone to one or more people who are on call evenings and weekends.
You can also specify different alarm destinations for statutory and special
holidays. For details, see “Setting up holidays” on page 34.
To set up a schedule for alarm notification, use the Schedule tab in the
Messenger Destination Setup editor.
To edit a cell,
double-click it.

To see the schedule for
holidays, click Show holidays.

When you double-click a cell in the schedule, the Schedule Detail dialog box
opens so you can specify which destinations receive notification of an alarm if
it remains unacknowledged for a certain period of time. You can specify up
to 25 destinations for each notification.
To assign the same destinations to multiple time periods, select the cells for the
time periods, and then click Edit.
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To display and
select destinations,
click Browse (...) to
open the Select
Destinations dialog
box.
Select the check box
to announce the
acknowledgement
only if the tag is in
alarm at the time of the
acknowledgement.
Clear the check box to
announce all alarm
acknowledgements.

Click to send notifications
until the alarm is
acknowledged.

Specify the notification time,
between 1 and 99999 seconds.
Click Browse (...) to open the
Select Destinations dialog box.

For alarms, you can set up continuous notification. Messenger continues to
send you notifications until the alarm is acknowledged. You can specify how
often you want notification and assign destinations.
For acknowledged alarms, you can set up Messenger to announce the
acknowledgement only if the tag is still in alarm at the time of the
acknowledgement.

Setting up alarm monitoring
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Setting up holidays
You can set up dates that will use the statutory holiday or special holiday
schedules. If a date is assigned to one of the holiday schedules, on this date
Messenger uses the holiday schedule instead of the regular schedule. You can
assign any dates to a statutory holiday schedule or special holiday schedule. A
special holiday is a day off scheduled by the company.

Select Statutory
Holiday or
Special Holiday.
Type the date of
the holiday.

Click to import a group of
statutory holidays. Follow the
instructions in the wizard.
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To add a single holiday to the
Select holiday list, click Add. To
remove a holiday, click Delete.

5
Chapter

Setting up phrases,
messages, and reports

Setting up text-to-speech
What is text-to-speech?
Text-to-speech is software for translating text so that it can be spoken by a
synthesized human voice. RSView32 Messenger™ comes with Microsoft® textto-speech software, but you might be able to use Messenger with SAPIcompliant text-to-speech software from other manufacturers. (SAPI is the
Speech Application Programming Interface.)
The text-to-speech voice is used with sound cards or voice cards when sending
alarm messages and reports to audio destinations. You can test how text-tospeech pronounces your messages and reports as you set up your project.

Bypassing text-to-speech
You do not have to use the text-to-speech voice to produce audio messages.
You can create your own audio recordings and import .wav files in the Audio
Recordings tab of the Messenger Setup editor. Messenger saves your
recordings in .wav format. For details, see “Creating and importing audio
recordings” on page 38.

Customizing text-to-speech
The Microsoft text-to-speech software is already set up with default values that
are suitable for most projects. You can customize these settings:



the text-to-speech voice
the pronunciation of unusual or industry-specific words that are not part of
the text-to-speech software’s normal vocabulary
■
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To set up the text-to-speech software, use the Setup tab in the Messenger Setup
editor.

Click here to
choose a text-tospeech voice.

Click here to add
or change the
pronunciation of
words.

If you use the Microsoft text-to-speech
conversion software that comes with
Messenger, the Setup button displays
the software version, and the Translation
button is inactive.

Choosing a text-to-speech voice
The default voice is called Mary. Test the default voice to see if it is suitable for
your project. While experimenting with voices, use these tips:






Use a male (lower-pitched) voice in spaces where there is little or no echo;
use a female (higher-pitched) voice in spaces where there is a lot of echo.
The higher the volume, the more difficult it is to understand what the voice
is saying. Keep the volume level at the lowest audible setting.
Test the voice in different settings. Choose a voice that sounds natural and
life-like while adapting to the environment in which it will be used.

Specifying the pronunciation of words
The text-to-speech software cannot always correctly pronounce words such as
company names, the names of people and places, technical terms, and so on.
For these words, before using them in messages and reports you will need to
define or correct the pronunciation.
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Type the word for
which to define
pronunciation
here...

...and then click
Next.

Specify how to pronounce the word by breaking it into syllables.

Click Play to hear
how the word
sounds.
Type short words
that have the
same sound as the
syllables of the
word you are
defining.

When the word
sounds right, click
Finish.

For the changes in pronunciation to take effect, you have to stop and then start
the RSView32™ project.
For additional tips, see “Working with text-to-speech software” in the
Messenger Help.

Setting up phrases, messages, and reports
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Creating and importing audio recordings
You can record words and phrases to use in your messages and reports. A
microphone is required to create audio recordings. You can use these
recordings in addition to or instead of messages spoken by the text-to-speech
voice.
Audio recordings are stored as .wav files. You can also import .wav files and
use them in your messages and reports. For example, you might use the
Windows® system file Chord.wav to signal the beginning and end of a report.
To create, import, or re-record audio recordings, use the Audio Recordings tab
in the Messenger Setup editor.
2. If an item has been added to the list
but nothing has been recorded yet, a
loudspeaker with a red X appears
next to the item.

1. To create an audio recording item, click
Add, and then type a name and click OK.

To import a .wav file, click Import.
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3. To make an audio recording, select the item in
the list, then click Record (red circle). Click Stop
(white rectangle) to stop recording. Click Play
(green arrow) to hear how the recording sounds.

Specifying and creating alarm messages
You can use the custom in-alarm, out-of-alarm, and acknowledge messages
that have been set up for each tag in RSView32, or you can use standard
messages that you set up in Messenger. You can also set up standard messages
for alarm faults and alarm suppression events, whether or not you use the
custom RSView32 alarm messages.
To specify or create alarm messages, use the Alarm Messages tab in the
Messenger Destination Setup editor.
To use the custom messages set up for each tag in
RSView32, click Use custom file messages or Use custom
printer messages.

You can specify alarm event messages
here even if you use the RSView32 tags’
alarm messages.

Click Play (green arrow)
to hear how a message
sounds.

To insert a tag property or audio
recording into the message, click
Browse (...) to open the Phrase
Components dialog box.

When you create alarm messages in this editor, you can include tag properties
for a specific tag or for the tag that is in alarm. You can also include audio
recordings, and type plain text.

Setting up phrases, messages, and reports
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Inserting tag properties and recordings
To insert a tag property or audio recording into a message, position the cursor
where you want to insert, and then click the Browse (...) button to open the
Phrase Components dialog box.
To insert a recording, click the Audio
Recordings tab.

To include a property in the report,
double-click it. If you are inserting the
property for a specific tag, first
specify the tag in the Tag box.

To insert the property for a specific tag, type the tag name here, or
click Browse (...) to open the Tag Browser, and then select a tag.

At run time, when an alarm message is announced, the text-to-speech software
speaks the plain text and the current values of the tag properties and Messenger
plays the audio recordings.
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Creating reports
You can create reports about alarm activity and other plant activity using any
combination of plain text, tag properties, and audio recordings.
To create reports, use the Messenger Reports editor.

To listen to your
report, click Play.

... click Browse (...)
to open the Phrase
Components dialog
box, and then
double-click the
property or
recording to insert.

Type the text to use in your report. With the
cursor positioned where you want to insert a
tag property or audio recording...

As with alarm messages, to insert tag properties or audio recordings use the
Phrase Components dialog box, shown in the previous section.
When you are finished creating the report, save it by choosing File>Save from
the RSView32 menu bar. Use the report’s file name, without the .vrp extension,
when you send the report at run time.

Using reports at run time
At run time, you can send a report to any destination by using the
MessengerReport command. For example, to send a report called Oventemp
to a destination called Supervisors E-mail, type this:
MessengerReport Oventemp /dSupervisors E-mail
If you do not specify a destination, the report is announced using the speakers
connected to the local Windows sound card. The report will contain the values
of tag properties at the time the command is issued. If you specify tags in the
report, the values for the specified tags will be used. If you do not specify tags,
the values for the most recent tag that is in alarm will be used.

Setting up phrases, messages, and reports
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Creating phrases at run time
At run time, you can create messages to report current plant activity. These
messages, which are generally shorter than your pre-defined reports, are called
“phrases.”
Type phrases on the command line, using the MessengerPhrase command.
For example, to send the current value of the tag called Oventemp to a
destination called Pager, type this:
MessengerPhrase “The oven has reached [Oventemp.Value] degrees.”
/dPager
If you do not specify a destination, the phrase is announced over the local
Windows sound card.
For details about formatting your phrases correctly, see “Phrase components
syntax” in Messenger Help.
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Setting up dial-in access

Using dial-in access
Dial-in capabilities are available at run time only if the run-time system has an
RSView32 Messenger Pro™ license, which must be purchased in addition to
RSView32™. You must activate the Messenger Pro license on your run-time
system.
For information about activating Messenger Pro, see Chapter 1, Installing
RSView32 Messenger.
Operators can dial in to:


listen to alarms



acknowledge alarms, either singly or all at once



play a Messenger phrase



run an RSView32 command or macro

Dialing and logging in
Operators must have a numeric user ID and a numeric password to log into
the system. Set up user names and passwords in the RSView32 User Accounts
editor.
To dial and log in
1.

Dial the phone number of the phone line to which the run-time computer
is connected.

2.

Type your numeric user name, and then press the # key.

3.

Type your numeric password, and then press the # key.

4.

Listen to the voice prompts and make your selections using the numeric
keypad on your touch-tone phone.
■
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The options available depend on how you set up the dial-in phone menus.

Preparing the voice card and setting up a greeting
To prepare the voice card for dial-in access and set up a greeting, use the Phone
Security tab in the Messenger Setup editor.
Type the number of the channel on
the voice card to use for dial-in
access.

Check this box to set
up the voice card for
dial-in access.

Type a greeting here,
and prompt the user to
enter a numeric user
name and password.
The user must press
the # key after entering
each number.

To insert a tag property or audio
recording into the message, click
Browse (...) to open the Phrase
Components dialog box.

Messenger supports phoning in using the Intel® Dialogic® ProLine/2V voice
card and the Intel Dialogic D/4PCI voice card. The ProLine/2V card has 2
channels. Messenger supports channels 1 and 2 on the D/4PCI card.
If you are using the voice card speaker destination, that destination occupies
channel 2.
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Setting up phone menus
You can set up these options for the dial-in phone menu:


a welcome message that the user hears once logged in successfully



an exit message that plays before disconnecting



the options on the Main Menu



the options on the Alarm Menu



the options on the Commands Menu



the error message that is spoken if the user enters the wrong number or
doesn’t respond to the voice prompts quickly

To set up options for the phone menus, use the Phone Menus tab in the
Messenger Setup editor.

Setting up voice prompts for the phone menus
You can set up separate voice prompts for each of the menus you plan to use.
The prompts tell users which buttons to press to select menu items.
Check this box to play
a welcome greeting
when the user has
logged in. Type the
greeting in the box.

Check the boxes for the
phone menus you want
to use. Type the menu
prompts in the text
boxes.
Type an exit message
to play before the user
hangs up.
Cick here to set up messages for
when the user enters an invalid
digit or doesn’t respond to the
voice prompts. Type the
messages in the dialog box that
opens.

Setting up dial-in access
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Setting up the Alarm Menu
You can choose which items to include on the Alarm Menu by removing
unwanted items from the Alarm Menu’s audio prompt.

Check this box to use
the Alarm Menu.
Remove unwanted
menu items from the
voice prompt in the
text box.
Clear this box if you
don’t want the operator
to acknowledge all
alarms from the Main
Menu.

Click Details to see the options
available on the Alarm Menu...

The * key on the Alarm Menu is reserved for returning to the Main Menu.
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Setting up the Commands Menu
You can use the Commands menu to run RSView32 commands and macros,
or to play Messenger phrases such as messages about tag status.

Check this box to use
the Commands Menu.
Type a voice prompt in
the text box to tell
users which buttons to
press to select menu
items.

Click Modify to set up the options on the
Commands Menu...
Specify whether to use
the menu for running
commands and
macros, or for playing
Messenger phrases.

Check the boxes for the menu
item numbers you want to use,
then...

...type a command, a macro
(multiple commands, separated
by a space or comma), or a
phrase...

...or click Browse to open the
Command Wizard or the
Phrase Components dialog
box.

The * key on the Commands Menu is reserved for returning to the Main Menu.

Setting up dial-in access
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Getting the information
you need

Using RSView32 Messenger Help
RSView32 Messenger™ Help provides overviews, reference information, and
step-by-step procedures for working with all of the features in Messenger. To
open Help while running RSView32™ you can:


click the Help button on any window.



on the RSView32 menu bar, click Help>Contents.

■
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Viewing the Help contents
For an overview of the Messenger Help, click the Contents tab, and then
double-click the RSView32 Messenger book.
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Using the index
The Help index is similar to an index in a book, listing keywords for topics in
the Help. To see the index, click the Index tab.

Learning more about using Help
To learn tips and tricks for getting the most out of the built-in Help system,
click Help>Using Help.

Finding RSView32 Messenger version information
To find the Messenger version number and serial numbers, click Help>About
RSView32, and then click Add-Ons. In the box, select RSView32 Messenger,
and then click Details.

Getting the information you need
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Finding information about RSView32
For information about RSView32, refer to these publications:
RSView32 User’s Guide

Rockwell Software, Publication ID 9399-2SE32UG
RSView32 Runtime User’s Guide

Rockwell Software, Publication ID 9399-2SE32RUG
RSView32 Getting Results Guide

Rockwell Software, Publication ID 9399-2SE32GR
These publications are also available on the RSView32 installation CD-ROM
and from the Programs>Rockwell Software>RSView32>RSView32 User’s
Guides menu.

Technical support
If you have a question about Messenger, please consult this guide or the
RSView32 Messenger Help. Or, click Help, Rockwell Software on the Web,
and then click the name of the web page you want to view. To use Rockwell
Software on the Web, you must have a web browser installed on your computer
and a current internet connection.
If you can’t find the answers, contact Rockwell Software Technical Support:
Telephone—440-646-5800
Fax—440-646-5801
World Wide Web Support web site—www.software.rockwell.com or

www.support.rockwellautomation.com

Support staff are available Monday through Friday from 8 A.M. to 5 P.M.
eastern time, except during holidays.
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When you call
When you call, be at a computer and prepared to give the following
information:


the product serial number
For RSView32 Messenger Pro, you can find this number on the Activation
disk label.



the product version number
You can find this number online. With the Messenger Setup editor selected,
click Help, and then click About Messenger Setup.



the type of hardware you are using



the exact wording of any messages that appeared on your screen





a description of what happened and what you were doing when the problem
occurred
a description of how you tried to solve the problem

You might also be required to provide information about other RSView32 addons and updates that are installed on your computer.
To view the list of installed add-ons and updates
1.

With the Project Manager window selected, click Help, About RSView32.

2.

Click Add-Ons to view the list of installed add-ons.

3.

Click Updates to view the list of installed updates.

Getting the information you need

■

53

Index
Symbols

C

.wav files
creating  38
importing  38

Commands
MessengerDestinationDisable  26
MessengerDestinationEnable  26
MessengerOn  15
MessengerPhrase  15, 42
MessengerReport  41
running using dial-in access  47
Commands Menu
setting up  47
Communications
setting up  15

A
Activation disk
activation keys  4
moving activation keys  5
protecting files  6
Activation files  3
Active Display Client
setting up  24
Alarm events
assigning destinations to  29, 30
Alarm Menu
setting up  46
Alarm messages
specifying  39
Alarm notification
scheduling  32
Alarm severities
assigning destinations to  29, 30
Audio prompts
setting up  45
when users dial in  44
Audio recordings
creating  38
importing  38
using in e-mail subject line  20
using in messages  40
using in reports  41

D
D/4PCI. See Intel Dialogic voice cards
Destinations
scheduling  32
setting up  15
turning on and off at run time  26
Dial-in access
logging in  43
setting up  43
setting up phone menus  45
turning on  44
using to play phrases  47
using to run commands and macros  47
Dialogic voice cards. See Intel Dialogic voice cards
Documentation
RSView32  52
RSView32 Messenger Help  49
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E

M

Editors
for Messenger  10
E-mail
connection requirements
setting up  19
EVMOVE.EXE  4, 6

Macros
running using dial-in access  47
Memory
minimum requirements  2
Messages
alarm  39
creating at run time  42
event  39
Messenger folder
editors  10
Messenger Pro. See RSView32 Messenger Pro
MessengerDestinationDisable command  26
MessengerDestinationEnable command  26
MessengerOn command  15
MessengerPhrase command  15, 42
MessengerReport command  41
Microsoft Exchange e-mail system  2
Microsoft text-to-speech software  35



2

F
Fax machines
modem requirements
setting up  18



2

G
Greeting
when users dial in



44

H
Hardware
minimum requirements  2
Help
RSView32 documentation  52
sample Messenger project  11
serial numbers  51
using online  49
version information  51
Holidays
setting up schedule for  34

I
Installing RSView32 Messenger
administrator rights  3
installation steps  3
Intel Dialogic voice cards  2
D/4PCI  21
ProLine2/V  21
setting up  44
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O
Online help. See Help
Online user’s guides
installing  52
viewing  52

P
Pagers
modem requirements  2
setting up  17
Phone access. See Dial-in access
Phone destinations
setting up  21
Phone menus
setting up  45
Phrase Components dialog box
using  20, 40
Phrases
playing using dial-in access  47
using at run time  42

RSView32 Messenger Pro  1
activating  3
after installation  6
troubleshooting  8
with reset code  7
reactivating damaged key  7
setting up dial-in access  43
RSView32 Project Manager
editors  10

ProLine/2V. See Intel Dialogic voice cards
Pronunciation
specifying  37

Q
Quick start  15
setting up alarm monitoring  12
setting up communications  11
setting up dial-in access  14
setting up phrases, messages, and reports

12

R
Reports
creating  41
creating at run time  42
sending at run time  41
RESET.EXE  4, 7
RSView32
documentation  52
enhancing  1
version requirements  2
RSView32 Active Display Client
setting up  24
RSView32 commands
running using dial-in access  47
RSView32 Messenger
assigning security to  9
finding serial numbers  51
finding version information  51
Help  49
installing  3
sample project  11
system requirements  2
RSView32 Messenger Client Control  24



S
Sample project  11
Schedules
setting up  32
setting up holidays  34
Serial number
finding online  51
Software
operating systems  2
Sound Blaster sound cards  2
Sound card speakers
setting up  22
Sound cards
compatibility requirements



2

T
Tag properties
using in e-mail subject line  20
using in messages  40
using in reports  41
Tags
monitoring for alarms  27
Technical support
contacting  52
resetting damaged activation keys
Telephone access. See Dial-in access
Telephone notification
hardware requirements  2
setting up  21
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Text-to-speech software
choosing a voice  36
Microsoft  35
specifying pronunciation
tips  36



37

V
Version information
finding online  51
Voice card speakers
setting up  23
Voice cards
setting up  44
supported types  2, 21

W
Windows operating system software
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©2003 Rockwell Software Inc. All rights reserved. Made in the United States of America. RSView32 Messenger and the Rockwell Software logo are trademarks of Rockwell Software Inc. All other trademarks
are the property of their respective holders and are hereby acknowledged.

Doc ID VWMSGR-GR002A-EN-P

